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ArcReader tutorial

IN THIS CHAPTER
e Exercise 1:Viewing a map
e Exercise 2: Querying a map

e Exercise 3: Printing a map

The best way to learn ArcReader is to try it yourself. This tutorial guides
you through some basic ArcReader skills as you explore a map of Canada.

Exercise 1 introduces various ways that you can view a map in ArcReader.

Exercise 2 shows you how to query a map in ArcReader to get the most
information possible from: it.

Exercise 3 walks you through printing a map from ArcReader.

Each exercise in this tutorial takes between 15 and 20 minutes to complete.
You can either work through the entire tutorial at once or complete each
exercise one at a time.

Before you begin the exercises in this tutorial, install the ArcReader tutorial
data. To install the data, run the Tutorial setup during the ArcReader
installation. You also have the option of running the Tutorial setup
independently of the ArcReader installation.



Exercise 1: Viewing a map

In this exercise, you will open and explore a published map
with ArcReader. You will also use ArcReader to query data

on the map.

Starting ArcReader

1. Click Start on the Windows taskbar.
2. Click Programs, point to ArcGIS, and click ArcReader.

ArcReader opens.
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(=, Startup
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Opening an existing published map

1. Click File and click Open.
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|[Fle Edt View Iools Window Help

Chl+0

Beload

Liose:

€ Open Map from the Geogiaphy Netwark

Page Setup,
&5 Erirt [t +F

455 Properies.

1 CAWINNTWProfiles\ uli31434PersonalyGulf of St Lawrence2. prf
2 CAWINNTWProfiles\ uli31434PersonalyGulf of St LawrenceB pmf
BCAWINNTWPofiles\uli3 1434 PersonalyGulf of St Lawrenced pmf
A CAWINNTWPofilest uli31435Personal\Gulf of St Lawrence] pmf
Exit AlF4

Click the Look in dropdown arrow and navigate to the
Map folder on the local drive where you installed the
tutorial. (C:\arcgis\arcexe82\ArcTutor is the default

location.)

Select Published Map Document

Laak jn: I 3 ArcReader and Publisher

= Bl sl B

1 Data

GUlf of St. Lawrence. pmf:

File name: |Gulf of 5t Lawrence. pmf

Dpen I
ﬂ Cancel |

Files of tupe: IPub\ished Map Documents

. Double-click Gulf of St. Lawrence.pmf.

ArcReader opens the map.
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ArcReader can open published map files (.pmf) that have
been created in ArcMap using Publisher. These published
maps do not actually store the data shown on the map, but
rather reference the data, which may be stored on a local
disk, on another computer, or on the Internet. The map
document stores map elements, such as titles, scalebars,
and North arrows.

Table of
contents

Data toolbar

Map display

humoiano
Jannancn

Ly slsaie | o

R T =]

This is an example of a .pmf—the Gulf of St. Lawrence.pmf.
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This particular map contains the following layers in a data
frame named Gulf of St. Lawrence:

Layers What layers contain

Links to Web Sites Internet addresses

Cities Locations of population centers

Major Roads Locations of expressways and
primary highways

Base Map Contains land and coastline layers

A data frame is a frame on the map that displays layers in
the same geographic area.

The map portrays the Gulf of St. Lawrence and the
surrounding region. Notice that there are check boxes next
to each layer name in the table of contents. All layers that
are checked are drawn in the map display area.

Moving around a map

The Data toolbar has tools to move around the map and
query features on the map. Hover your cursor over each
icon (without clicking) to see the name of each tool. The
name is displayed in a ToolTip. This tutorial will use these
names to refer to specific buttons and tools. When you
interact with the map, one of these tools will be active, and
the pointer will change to the active tool when moved over
the map.

4> Gulf of St. Lawrence - ArcReader

J File  Edit “iew Toolz Window Help

(gl |||[eaaxaPdean @M 7500 ¢
Gulf of 5t. Lawrence -Z |

= [ Links to'web Sites m
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If you need more information about how a tool or command
works, you can quickly access the context-sensitive help
that is available for most tools. Press Shift+F1 on your
keyboard while hovering over the tool with the mouse.

#> Gulf of 5t. Lawrence - ArcReader

File  Edit “iew Toolz ‘window  Help

|
EEEIEEEEERT X

Zoom In tool

Zooms in on the data in your map. vou can click on a

lozation to zoorm in on i, oF you can use the tool to
drag a box to zoor in on a particular area,

Context-sensitive help for the Zoom In tool is shown above.

1. Click the Zoom In tool, then click and drag a box around
Anticosti Island and a portion of the St. Lawrence River.
This will make it easier to read the labels and see where
the cities and roads are located.

4> Gulf of St. Lawrence - ArcReader

Fle Edt Miow Iook Window Help

B"E&\QHEH@@:: ZO@ e |6 7 55maT 5

= Gulf of St. Lawrence @d}(
= [ Links to'weh Sites

(5] il
= W Cities

« Towe o Vilage QUEBEC

o Smal City
o Ciy
= ) Major Roads
Map tips show #
— Expressway
—Primary Highway
= ¥ BaseMap
= U.5. - Canadian Bord

tnrce:
GTT o eme =1 ot

St. Lawrence

[ ¥ Coast lines e, S K e At

O
= ¥ Masine
]
Cabot
Strait

=) Land
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2. Using the Pan tool you can interactively manipulate the
map. Click the Pan tool, then click the map and hold
down the left mouse button to drag the display in any
direction.

axumdan

Pan tool

3. The Go Back and Go Next buttons can be used to revisit
any of the places to which you have previously zoomed
or panned. Click the Go Back button now to view the
previous map extent.

J@Q o5 B é‘“?@ﬂ# Y Y B
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Using bookmarks

Bookmarks are named map extents created by the publisher
of the map. The publisher zooms to a specific view of the
map and saves it for future use. You can access the
publisher’s saved extents by selecting Bookmarks.

1. Click the View menu, point to Bookmarks, then click
Prince Edward Island.

£ Gulf of St. Lawrence - ArcReader

J File Edt | Wiew Toolz ‘window Help

Jﬁ%|é Data View }:WO"|0ME
Gulf of St (& Lavout View
B [ Links te
= Zoom Data 3
d Cities Zoom Layout »
- Tow

Bookmarks Prince Edward |zland
o Sme

@ City 5 Gulf of 5t. Lawrence e

o Msior F Toolbars
ajar o 44
Ma E Table of Contents e

—Exp |7 Status Bar

—Frire
= Base M GIT Scrollbars
=

IR

Fores uille
u

Fiefrezh F5
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The map now shows Prince Edward Island.

£ il ol 51 Lsmmepmen - Artfieasien

/ PRINCE EDWARD

) A ISLAND
= NS 46,3_11Tmfﬂﬁé\@@mggg_q.-ﬁ———'—-@auﬁs

¢ e, Charloftetown” .+

(11279 T et [

2. Click the View tab, point to Bookmarks, then click Gulf
of St. Lawrence to reset the map to its original display.

To learn how to set bookmarks, see Using ArcMap.
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Turning layers on and off

The table of contents is where you turn map layers on and
off. To display a layer, check the Layer visibility check box
next to its name. To turn the layer off, uncheck the box.

L.
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Check Links to Web Sites.

Notice the blue question mark symbols now draw on the
map.

. Uncheck the Links to Web Sites.

Notice that the layer is turned off and no longer displays
on the map.

4> Gulf of 5t. Lawrence - Arqg

| Fle Edt Wiew Took °

A= EER By
=F Gulf of 5t. Lawrence
@ = Links toweb Sites
|
=l Cities
«  Town or Village
o Small City
@ City
= Major Roads
tdap tips show #
—Ewprezsway
—Primary Highway
= Baze Map

Layer visibility check box

Getting information about layers

Each of the layers in a map has a set of properties that can

be viewed, allowing you to learn what features are available
for that layer.

1. In the table of contents, right-click Major Roads and

click Properties.

£ Gulf of 5t. Lawrence - ArcReader

J File Edit  Wiew Toolr ‘Window Help

2xaglel|jleaaxad e

=% Gulf of S5t. Lawrence
= [ Links to'weh Sites
&

= Cities

o Town or Yillage

o Small City

@ City

b -Eiljl' Roads
tdap tips show #

—Ewprezsway

—Primary Highwway Find...

= Baze Map I
=] 115, - Canadian B

Zoom Tao Layer Extent
Zoom (o fd ate sl

|dentify...

— Properties. .. 1
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2. Click the General tab.

You can see whether the layer is displayed at all scales
or only within a specific range of scales and whether
Map Tips have been enabled for the layer. Map Tips are
onscreen descriptions of map features that appear when
you hover the mouse pointer over a feature. Later in this
tutorial you will use Map Tips from this layer.

3. Click OK to close the Layer Properties dialog box.

Layer Properties - Major Roads

| Source I

— Scale Range
The scale range for this laver has been specified to be:
Show layer at all scales
[am bt ayenmwhen sacmed

oubbepond T O

[minimum scale]

i bepand s 0

[marimur scale]

Figld Shawn In Map Tips: Mumber
Frimary Dizplay Field: Mumber
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Using the magnifier window

There are times when you may not want to change the
location displayed on the map but still need to see more
detail. The ArcReader magnifier window allows you to do
this.

1. Click Window and click Magnifier.

#= Gulf of 5t. Lawrence - ArcReader

| Fle Edt Wiew Took | Window
[zma|o]le

The magnifier window opens.

Help

2. Click the title bar of the magnifier window and drag it
over the map. While you are dragging it, the magnifier
window will show a crosshair to indicate what part of
the display will be magnified.
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3. When the crosshair is over the portion of the map you
would like to magnify, release the mouse button. You will
see a magnified view of the location under the magnifier.

While dragging

Magnifier Windaw =] b Wf

s |
f of s st obicn

rence

Cab ot

.
ot
f.’ﬁ = Strait

Result after dropping

Changing the magnifier window properties

You can change several of the magnifier window
properties, such as the magnification factor and what the
magnifier window displays.

1. Move your cursor near the edge of the magnifier
window, then click and drag the cursor in the direction
you want to resize the window (make it a little larger).

16

2. Place your cursor in the middle of the magnifier window

and right-click.

. Point to Magnification Factor and click 800%. This will

scale the data displayed in the magnifier window by the
percentage chosen.

I agnifier Window

Buctouch:

Magnification Factor 200%
W 400%
GO0

Snapshot
Update while dragging

4. Right-click the magnifier window and click Snapshot.

Move the magnifier window somewhere else; notice that
the picture doesn’t change, but instead keeps your
snapshot.

. Toreenable the magnifier, right-click the magnifier

window and click Snapshot again. The window redraws
to magnify the section of the map it is over. When you
have finished experimenting with the magnifier window,
click the Close button to close it.
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Data view and Layout view

ArcReader is capable of displaying a map in either Data
view or Layout view. Up to this point this tutorial has been
using Data view. Data view shows the contents of a data
frame. Layout view shows the map as it would appear on a
printed page. Layout view also shows map elements that
aren’t contained within the data frame, such as the map
title, legend, scalebar, and North arrow.

1. Click the View tab and click Layout View.

£ Gulf of St. Lawrence - ArcReader

| Ele Edi | wiew Tooks window

J = Dy | E Data Yiew r

& Gl of St &

= [ Links to = . N
= Zoaom D ata

= Cities Zoom Layout 4
* Toy EBookmarks 4
o Sm:
° _E't-"' Toolbars L4

= Major F

Ma ,E Table of Contents
—Exp F Status Bar

o B:SZ[;:' [ Scrollbars
C
BMUS R F5

The map displays in Layout view. Notice the page
includes a title, legend, scalebars, and some supporting
text. Also displayed is the Layout toolbar, which contains
tools for navigating in Layout view. Hover your cursor
over each icon, without clicking, to see the name of each
tool.

The Layout tools in the Layout toolbar are used like the
tools in the Data toolbar. They allow you to change the way
the page is displayed. Notice that the data tools are still
accessible for changing the view of the data within the data
frame.

ARCREADER TUTORIAL

There is a shortcut for switching between Data and Layout
view. In the scrollbar near the bottom of the map, there are
three small buttons. Clicking the globe icon switches to
Data view, clicking the page icon switches to Layout view,
and clicking the arrow icon refreshes the map.

Page for map Layout toolbar

| Ba B0 Yen Tsch ledee
CIC T

Ses ona T H EED

[ [T 0s0Sinches

Refreshes

sy _-:'-:[ﬂ
Data view/| Layout view

In this exercise, you learned various ways to view a
published map in ArcReader. In the next exercise, you will
learn how to query a map in ArcReader.
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Exercise 2: Querying a map

A map in ArcReader typically contains more information
than you initially see. For example, a feature may hold
attribute information that is not labeled or displayed on the
map. With ArcReader you can query that information or
use Map Tips to find a feature on the map.

Using Map Tips

The most readily accessible kind of map attribute
information comes in the form of Map Tips. A Map Tip is
an attribute chosen by the map author that displays
whenever you hover any data tool over a feature on the
map. Map Tips are only visible while in Data view.

1. Click the Data view button, located at the bottom-left
part of the map. [@

2. Click any data tool and hover over a road to see its
name.

ignish

PRINCE EDWARD

Road name

18

The Major Roads layers is the only layer in this map that
has Map Tips enabled. You can tell if Map Tips are enabled
for a layer by right-clicking the layer name in the table of
contents and clicking the General tab on the Properties
dialog box.
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Identifying a location

You can use the Identify tool to get two kinds of
information—you can see what features are at a specific
location and also investigate the attributes of each feature.

1. Click the Identify tool.
The Identify window opens.

O—ﬂEM o AR

2. Click the Identify from dropdown list and click <Visible
layers>.

i ldentify Features on the Map E ]

= EEDE'E‘ fines Locatior: [157,060.84 7 274,517 37 Meters =
e Field | value |

Shape Paolygon
Mame | Land

3. Click the View menu, click Bookmarks, then click Prince

Edward Island.

ARCREADER TUTORIAL

4. Click the dot that represents the city of Charlottetown.

/’T ignish

< PRINCE EDWARD
0\ 3 ISLAND

% iu L"ﬁfﬁhaé*i(eﬂ\sjijrlgtoﬂ,bfﬂ_'_gﬁuris
a3 '%,bmrl QW
7 % / o
o 9 0] "l
\ 5 /)O, S“f E
e /¢

Notice that the Identify tool located not only information

about Charlottetown but also information about the

Major Roads, Coast lines, and Land. The identify results

include all visible layers.

i Identify Featurez on the Map EHE
| dentify fram: I<\"’isible layers: j
=l C"'e Location: [182,574.16 / 256,166.23 Meters =
l M ajor Roads Field I Y alug -
[ Coast lines Shape Faint
- Land Province Abbr, PE
City Hame Charlattetown
Dregignation Termn City F—
UTH Map Grid Cell 01103
Population Categony 2
Province Mame Frince Edward [
1998 Populatlon 3253 -
4 | =
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Identify window commands

Right-clicking features, layers, or their attributes in the
Identify window opens a context menu with options for

working with the fields for that feature or layer.

Layer Location
de ap X
Identify fram: | <\isible layers:> v
E- Cities Location: [T62:874.16 7 -268, 168,23 Meters d
Major Ro Field | Walue | =
Coast lines Shape Paint
Frovince Abbr. FE
City Mame Charlottetown
[resignation Term City
UTH Map Grd Cell miLoz
Population Category 2
Province Mame Prince Edward |sland
199E Population 3251
Area [km) 42 B4
Eirths 1996 425
Deaths 1936 435
* Adults Completed University 20.5%
Ay, Income 1996 [working perzonz)| $22,000.00
Murnber of Families 1336 G450 j
Awerage Home Walue 1395 $112,754.00 LI
Attributes

1. Right-click a layer or feature. The options in the context

menu allow you to expand all the fields, collapse the
Identify tree, sort the fields, or copy a record.

2. Right-click an item in the Value column. The options in
the context menu allow you to organize the Field values.
You can hide or show all the fields, select all the fields,

change the order of the fields (inverse selection), or

copy all the fields. If you click Copy, you can then paste
the information into another application, such as a text
editor or a spreadsheet.

20
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de eature: o e Map 7| =
Identify from: |<Visible lavers> i
| Location: [182,87416 / -265.165.23 Meters E]
Expand All Chl + | Walue | o
Collapze Tree Chil - Pairt
S PE
Sorted Chrl+5 Charlatletown
City
Copy Record  Cirl+C o1iLo

Fopulation Category 2

Frovince Mame P Hide Field[s] Del

1956 Population 3 .

brea [k 1 Show &l Fields  Ins

Eirthz 1996 4 o

Deaths 1996 4 SelectAl FIE|C|.S Chrl+s

% Adults Completed University 2 Inverse Selection Chrl+l

A, Income 1996 [working persons] | § -
Hurnber of Families 1995 6 Copy Chl+C
Awverage Home Walue 1996 $112./09.00 LI

Click the small dropdown button to the right of the
Location text box to open a menu that will allow you to
display the location of the city in the units of your
choice. Click Meters.

i ldentify Features on the Map

| dentify from: |<V\sible layers> h
- Cites Location: [182,874.16 7 -268,156.23 Melers £
- Charlottetown - Filometers

- Major Roads Field [ Vale [« v Meters

- Coast lines Shape Paint Decimeters

-Land Province Abbr. PE
City Mame Charlottetown Ez.al.wllmelers
Diesignation Termn City Millmeters
UTHM Map Grid Cell 011L03

Papulation Categary Hautical Miles

Province Name Prince Edward lsland Standard Miles
15996 Population 32,531 Yards

Area [km] 4284 Feet

Births 1996 425

Deaths 1996 435 Inches

% ddults Completed University 208% Decimal Degress

Ay, Income 1996 [working persong] - $22,000.00
Mumber of Familiss 1996 3
Average Home Value 1996

£ ~  DegMinSec
$112,754.00 ﬂ

4. Close the Identify window.
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Finding a location

In ArcReader it is easy to find a feature based on a name
or value using the Find tool.

1. Click the Find tool.
The Find dialog box appears.

& dh & 7

2. In the Find text box, type “Lourdes”.
Click the In layers dropdown arrow and click <All
layers>.

4. Click Find. ArcReader locates the city called Lourdes
and shows it as a row in the Results section of the
window.

98]

Features | Find |

Find: |L0ur:jes _J Stop |
In layers: |<AII layersy J New Search |

¥ Find featurss that are similar to or contain the search sting

Search: & 4l fields @
© In lields j

Shape

' Each layer's primany dizplay fisld

Cloze I

Right-click a row to zhow context menu.
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Once you’ve found a place, you can use the Find dialog
box to navigate to or learn more about the feature.

5. Inthe Find dialog box, right-click Lourdes and click

Zoom to feature(s). ArcReader zooms to the city of
Lourdes.

. Make sure the Find dialog box does not cover the city of

Lourdes. In the Find dialog box, right-click Lourdes and
choose Flash feature. Lourdes will flash.

. Right-click Lourdes and click Identify feature(s). The

Identify Features on the Map dialog box, which contains
all the attribute information for the city of Lourdes,
appears.

Walue Layer Field

Flash feature

Zoom to feature(z)
Identify feature(s]

One object found. 4

60 o

Results section of Find
dialog box

. Close the Identify Features on the Map dialog box and

the Find dialog box.
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Using hyperlinks

Maps viewed with ArcReader may have hyperlinks to
provide additional information about certain features. The
Gulf of St. Lawrence map contains hyperlinks in the Links
to Web Sites layer. Hyperlinks are only available in Data
view, and you will need an Internet connection to use this
tool. Click the View menu, point to Bookmarks, click Prince
Edward Island, then continue with the exercise.

1. Check the Links to Web Sites layer in the table of
contents. You should see a blue question mark appear on
the screen. If the question mark does not appear, zoom
out until it becomes visible.

2. On the Data toolbar click the Hyperlink tool to activate
it. Notice that a blue dot appears over the question
mark. This blue dot indicates hyperlinked features. The
Links to Web Sites layer is the only layer with hyperlinks
in this map.

Y 7 [15528217 =]

o
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3. Hover the Hyperlink tool over the center of the blue dot
hyperlink. The cursor changes to a pointing hand. Click
to open your default Internet browser. The official Web
site of the Government of Prince Edward Island,
Canada, where you can learn more about Prince
Edward Island, displays.

| B E@ ¥ew Toch Wedw Eeb
|[E & n|[@E
P Ol 6, Lomonn [ ==
-'!_lixlo\\hbSIu

O W [F e o
TaTeT —=
* wMurdochvile

7
: o o
Saspa ¢

Perceg
Chandler a
b

D
) S dTTRE-AY
o

Gulf of @

(el NewRenmong St. Lawrenc

% Mo n-uentn  Balforst IRRCTE Ml
Lot SR
pra Mirarmichi =
(_/:b. b -1:qn|s:'.

NEW@ /- PRINCE EDWARD &
INSWICK | \ . @ ISLAND e
sdover - Buctouche N, £ SUMMATSITE o cinoron Spuns fsla

o ; o2 A "
L] ) Shedisc ”’ébﬁ;‘- n”r.';".""'_“.”__. \
Fredericlon | Mancton e 2 it .

| m@_-_ =7 e anils y, Aarerst

Using ARcREADER AND ARcGIS PUBLISHER



Measuring distance

You can measure distances in ArcReader. The ArcReader
Measure tool allows you to see how far apart two places
are or even plot a route and check its distance.

1. Click the View menu, point to Bookmarks, then click
Measured Journey.

2. Click the Measure tool on the Data toolbar.

O PED OM e F
|

Measure tool

. Click Port-Cartier, then plot a course through the Gaspé
Passage and on to Cape St. George by clicking each
time you want to change directions.

(98]

S~

. Double-click on Cape St. George to finish measuring.

The line you drew disappears.

Lourdes
.
Cape B Gl

Gutfof
Si. Lawrence
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There are a few things to notice as you do this. First, on the
ArcReader status bar in the lower left, you will see the
current segment’s length. Second, you will see the total
distance you have measured.

0 ISIRERENET

Segment: 301936274 Total 595 666417 Kilometers

In this exercise, you learned various ways to query a
published map to get more information from it. You learned
about Map Tips and the various tools that let you investigate
more closely the information a map contains. In the next
exercise, you will learn how to print a map in ArcReader.
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Exercise 3: Printing a map

To perform the following exercise, you will need to have a

printer available. The printer should be able to print a letter
size (or A4) sheet of paper and can be cither a black-and-

white or color printer.

1. Click the ArcReader File menu and click Page Setup.

The Page Setup dialog box opens. This dialog box
contains options that let you change which printer you
are using or change the settings for that printer.

£> Gulf of St. Lawrence - ArcReader

|[ Fie Edt View Tooks Window Help
= Open... Chil+0
EBeload

LClose

2 Open Map from the Geoaraphy Metwark,

& Frirt... Crl+F

Map Properties...

1 CharcgizharcexeS2vA e Tutor\ArcR eader and Publisher\Gulf of St. Lawrence. pmf
2 CANWIMMT S ProfileshJuliz1 43WPerzonal\Gulf of St Lawrence2. pmf
3 CAWANMT YProfilestJuli31 434Personal\Gulf of St. LawrenceB. pmf
A CAWIMMT ProfileshJuli31 434 Perzonal\Gulf of St Lawrenced, pmf
Exit AleeF4

2. If the printer you want to print from is set as your
default printer, skip to Step 3. Otherwise, click Printer in
the Page Setup dialog box and choose the printer to
which you want to print your map.

24

3. Click Landscape.

4. In the Printer Setup box, click the Size dropdown arrow
and click Letter (or A4).

Note that it is possible to print this map to a larger or

smaller paper size by checking the Scale to fit Page check

box in the Page Setup dialog box. The map will scale up or

down to fit the page.

5. Click OK.

[l Fage Setup

— Printer Setup
Frinter: I “htypatburyan =l
o_—‘ Size: ILE"ET j
— Dnentation Layout Settings
" Portrait [ Show Marging
™ Scale ta fit Page

Frinter...

(] I Cancel
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Printing a map
1. Click the Layout view button.

It’s important to switch to Layout view because your
printing results can vary depending on what view you are
in. Printing in Data view will print the currently displayed
data frame at the current extent to the selected paper size.
The printed data will be scaled to fit the page size selected
in Page Setup. When printing from Layout view the entire
published page is printed.

2. Click the File menu and click Print.

@IE R

| [11.0%85Inches

In Layout view the original page size
is displayed on the status bar.

ARCREADER TUTORIAL

3. Click OK.
Print HE
r Printer
M arme: oo bRy an Properties |

Status: Ready
Type: HF Laserlet #4474k PostScript
Where: M2 South

Comment: win2k and ntd drivers [~ Print ta file
r— Print range Copies
Lo Mumber of copies: |1 3:
) Pages _from:l _to:l
@ ™| Collate
€ Selection

.
®

Cancel |

In this tutorial you have been introduced to viewing,
querying, and printing published maps with ArcReader. The
next chapter provides more detail about these tasks as well
as information about published maps and their uses in
ArcReader.
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